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ABSTRAK 

 

Teknik pemotongan pada antena RLSA ini memiliki kekurangan yaitu kebocoran daya pada bidang potongnya. 

Untuk mengatasi itu, diberikan penutup tembaga pada bidang potong. Pada penelitian ini penambahan lapisan 

tembaga pada bidang potong dibagi dalam 4 skenario penutup tembaga di antara feeder dan tepi antena, 

penutup tembaga dari tepi antena, penutup tembaga dari arah feeder, penutup tembaga di tengah bidang potong 

di atas cavity tambahan. Antena bekerja lebih baik apabila posisi dan panjang lapisan tembaga pada bidang 

potong berada di tepi antena, tetapi bukan berarti performansi antena akan mendapatkan nilai terbaik. Sebagai 

contohnya dapat dilihat dari skenario 2 dengan panjang 84 mm sebagai bandwidth terbaik sebesar 1,1047 GHz, 

lalu skenario 1 dengan panjang 63 mm sebagai S1,1 terbaik sebesar -35,82 dB, dan skenario 2 dengan panjang 

93 mm sebagai gain terbaik sebesar 15,51 dB. Posisi dan panjang lapisan tembaga yang dekat dengan ± 15 mm 

mendekati Feeder memiliki nilai S1,1 ≥ -10 mm, dan bandwidth yang tidak bekerja pada frekuensi 5,8 GHz 

sehingga tidak sesuai standar acuan antena.  

Kata kunci: Antena RLSA ½ lingkaran, kebocoran daya, penutup tembaga, performansi antena, bidang 

potong 
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ABSTRACT 

 

The cutting technique on this RLSA antenna has a drawback, namely the power leakage in the cutting plane. 

To overcome this, a copper layer is applied on the cutting plane. In this study, the addition of a copper layer 

on the cutting plane was divided into 4 scenarios, that is a copper layer between the feeder and the edge of the 

antenna, a copper layer from the antenna edge, a copper layer from the feeder direction, and a copper layer 

in the middle of the cut plane above the additional cavity. The antenna works better when the position and 

length of the copper layer in the cut plane is at the edge of the antenna, but that does not mean that the antenna 

performance will get the best value. For example, it can be seen from scenario 2 with a length of 84 mm as the 

best bandwidth of 1.1047 GHz, then scenario 1 with a length of 63 mm as the best S1,1 of -35.82 dB, and 

scenario 2 with a length of 93 mm as the best gain of 15. 51 dB. The position and length of the copper layer 

close up to ± 15 mm near the feeder has a value of S1,1 -10 mm, and the bandwidth does not work at a frequency 

of 5.8 GHz so it does not match the antenna reference standard.  
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BAB I 

PENDAHULUAN 

 

1.1. Latar Belakang 

Pada zaman teknologi saat ini, telekomunikasi merupakan salah satu bidang yang 

berkembang dengan cepat. Hal ini dapat dilihat dari banyaknya penelitian-penelitian 

mengenai antena yang merupakan bagian penting dari teknologi wireless. Dari semua 

penelitian antena, antena RLSA (Radial Line Slot Array) adalah antena yang masih diteliti 

hingga saat ini. Awalnya antena RLSA diterapkan pada satelit untuk menggantikan antena 

parabola. Hal ini dilakukan karena keunggulan dari antena RLSA tersebut, yaitu letak feeder 

antena RLSA yang terletak pada bagian belakang piringan antena. Sehingga saat sinyal 

masuk atau keluar dari antena tidak terganggu. Selain itu antena RLSA juga memiliki gain 

dan efisiensi yang tinggi [1, 2]. Karena keunggulannya tersebut penelitian saat ini lebih 

memfokuskan bagaimana cara menerapkan antena RLSA pada perangkat yang lebih kecil.  

Namun setelah bertahun-tahun, penelitian antena RLSA yang dihasilkan memiliki 

koefisien refleksi yang tinggi, hal ini disebabkan jumlah slot sebagai tempat sinyal keluar 

tidak cukup [3]. Seperti pada penelitian [4] yang merancang antena RLSA dengan desain 

posisi slot yang sederhana agar bisa mengecilkan jari-jari antena untuk teknologi WLAN 

indoor. Tetapi antena yang dihasilkan pada penelitian ini memiliki performansi yang kurang 

baik. Beberapa peneliti telah melakukan penelitian untuk mengatasi masalah tersebut. 

Seperti pada penelitian [5] merancang antena RLSA dengan material FR-4 [5]. Keuntungan 

dari material FR-4 ini yaitu material dengan biaya yang rendah dan juga mudah untuk 

dirancang sebagai alat. Tetapi antena yang dihasilkan penelitian [5] ini memiliki gain dan 

bandwidth yang rendah, karena pada proses pembuatan antena slot tumpang tindih.  

Beberapa tahun selanjutnya, pada penelitian [6] mengenalkan teknik untuk dapat 

mengatasi rendahnya performansi pada antena RLSA berdiameter kecil, yaitu teknik 

extream beamsquint. Teknik ini membuat antena memancarkan daya lebih efisien dan 

mengurangi daya yang direfleksikan. Antena yang dihasilkan menggunakan teknik ini, 

menghasilkan antena dengan posisi slot yang tidak berbentuk spiral, dan ada bagian yang 

tidak memiliki slot pada bagian radiating. Hal inilah yang menyebabkan munculnya 

pengembangan teknik pemotongan, karena tidak adanya slot sebagai tempat keluarnya daya 

pada salah satu area dibagian radiating.  
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Penelitian tersebut dimulai pada penelitian [7], yang merancang antena ½ lingkaran 

di frekuensi 5,8 GHz. Penelitian ini merancang antena dengan berbagai ukuran jari-jari dan 

beamsquint. Hasil dari penelitian ini menunjukkan, apabila jari-jari lingkaran antena RLSA 

½ lingkaran diperbesar performansi antena semakin bagus. Selanjutnya ada juga penelitian 

[8] yang berhasil merancang antena RLSA ½ lingkaran dengan dua arah pancaran (dual 

beam) pada frekuensi 5,8 GHz. Pada penelitian ini dengan memanfaatkan bagian ground 

pada antena RLSA dan menempatkan slot sebagai tempat keluarnya daya, sehingga antena 

RLSA dapat menghasilkan dua buah pancaran (dual beam). Setelah itu ada juga penelitian 

[9] yang merupakan lanjutan dari penelitian [8] sebelumnya, dan berhasil merancang antena 

RLSA ½ lingkaran dengan dua arah pancaran yang bekerja pada frekuensi 5,4 GHz dan 5,8 

GHz. Penelitian teknik pemotongan tidak hanya memotong antena menjadi ½ lingkaran saja. 

Penelitian antena RLSA dengan teknik pemotongan terus dilanjutkan dan berhasil 

merancang antena RLSA 1/3 lingkaran menggunakan teknik dual band, dan teknik dual 

beam [10, 11]. Selain itu ada juga penelitian yang berhasil merancang antena RLSA ¼ 

lingkaran yang juga menggunakan teknik dual band, dan teknik dual beam [12-15].  

Walaupun dengan menggunakan teknik pemotongan dapat mereduksi ukuran antena, 

namun antena yang menggunakan teknik pemotongan memiliki kebocoran daya yang terjadi 

di sepanjang bidang potong antena. Sehingga keluarnya sebagian daya pada bidang potong 

antena menyebabkan performansi antena (gain, bandwidth, dan koefisien refleksi) menurun 

[16, 17]. Oleh karena itu dilakukan penelitian dengan menambahkan penutup tembaga pada 

bidang potong antena RLSA ½ lingkaran. Hal ini dikarenakan berdasarkan teori daya keluar 

hanya melalui slot pada bagian radiating berbahan tembaga, dengan alasan itu maka 

penambahan penutup tembaga tanpa slot pada bidang potong dapat membuat daya tidak bisa 

keluar di bidang potong. Dengan melakukan analisis penutup tembaga pada bidang potong, 

maka penulis dapat rekomendasi penelitian dengan judul “Analisis Efek Penutup Tembaga 

pada Antena Radial Line Slot Array ½ Lingkaran”. 

 

1.2. Rumusan Masalah 

Rumusan masalah dari penelitian ini adalah bagaimana menganalisis efek dari 

penutup tembaga pada antena radial line slot array ½ lingkaran. 
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1.3. Tujuan Penelitian 

Tujuan dari penelitian ini adalah untuk mengetahui efek dari penutup tembaga pada 

antena radial line slot array ½ lingkaran. 

 

1.4. Batasan Masalah 

Untuk menjaga agar pembahasan agar lebih terarah dan tidak telalu luas sehinnga 

dapat mencapai hasil yang diharapkan, maka penulis menetukan beberapa batasan masalah, 

yaitu: 

1. Antena yang disimulasikan adalah antena RLSA ½ lingkaran.  

2. Antena disimulasikan dengan frekuensi 5,8 GHz. 

3. Lapisan penutup tembaga hanya ditambahkan pada area bidang potong. 

4. Parameter yang dianalisa pada penelitian ini adalah Gain, Bandwidth, dan 

Koefesien Refleksi. 

5. Penelitian ini hanya terbatas dalam simulasi saja. 

 

1.5. Manfaat Penelitian 

Manfaat dari penelitian ini adalah: 

1. Mengetahui apakah penambahan tembaga pada bidang potong antena RLSA ½ 

lingkaran dapat meningkatkan performansi antena. 

2. Menjadi acuan dasar penelitian selanjutnya mengenai kebocoran daya antena 

RLSA ½ lingkaran dengan penambahan tembaga pada bidang potong antena 

yang bekerja pada frekuensi 5,8 GHz.  
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BAB II  

TINJAUAN PUSTAKA 

  

2.1. Penelitian Terkait  

Penelitian antena RLSA saat ini, lebih meneliti tentang bagaimana cara mereduksi 

ukuran antena agar dapat menerapkannya pada perangkat yang lebih kecil. Hal ini dapat 

dilihat dari banyaknya penelitian antena RLSA yang menggunakan teknik pemotongan, 

yang menghasilkan performansi antena dari segi gain, bandwidth, dan koefisien refleksi 

yang baik. Berikut ini beberapa penelitian antena RLSA yang menggunakan teknik 

pemotongan: 

 

Tabel 2.1. Literatur Review Penelitian Antena RLSA dengan Teknik Pemotongan 

No Judul Literatur Tahun Spesifikasi Hasil Penelitian 

[7] Analisa Pengaruh 

Pemotongan pada Antena 

RLSA ½ Lingkaran di 

Frekuensi 5,8 GHz 

dengan Menggunakan 

CST Studio 2010 

2016 P0 = 14 

Tau =75o-89o 

Jari-jari = 75-115 

mm 

Menyimpulkan bahwa 

semakin besar jari-jari, dan 

Tau performansi antena 

semakin bagus. Dengan 

spesifikasi terbaik pada 

jari-jari 115, P0 14, dan 

Tau 89. 

Gain=15.55 dB 

S1,1=-35,03 dB 

Bandwidth=0,863 GHz 

[18] Pembuatan Prototype 

Antena RLSA untuk 

Verifikasi Hasil Simulasi 

Teknik Pemotongan ½ 

Antena RLSA pada 

Frekuensi 5,8 Ghz 

2016 Tau = 78 o 

Jari-jari = 75 mm 

Rancangan antena RLSA 

½ lingkaran. 

Gain=10,1 dB 

S1,1=-11,34 dB 

Bandwidth=1,020 GHz 

[8] Rancang Bangun 

Prototype Antena Radial 

Line Slot Array dengan  

2017 P0=14 

Tau = 60o 

Jari-jari = 75 mm 

Rancangan antena RLSA 

½ lingkaran dual beam.  

S1,1 = -16,89 dB 
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Tabel 2.1. Literatur Review Penelitian Antena RLSA dengan Teknik Pemotongan 

(Lanjutan) 

 Teknik Pemotongan ½ 

Lingkaran dan Teknik 

Pembagian Dual Beam 

pada Frekuensi 5,8 GHz 

  Gain = 10,27 dB 

Bandwidth = 1098 MHz. 

[9] Rancang Bangun 

Prototype Antena Radial 

Line Slot Array Dual 

Band Dual Beam 

Menggunakan Teknik 

Pemotongan ½ 

Lingkaran pada 

Frekuensi 5,4 GHz dan 

5,8 GHz 

2018 P0=10 dan 12 

Tau= 50o dan 70o 

Jari-jari = 115 mm 

Rancangan antena RLSA 

½ lingkaran dual band 

dan dual beam.  

S1,1 = -19,68 dB dan -

19,32 dB.  

Bandwidth = 148,7 MHz 

dan 316,4 MHz. 

 

Walaupun begitu teknik pemotongan ini memiliki kekurangan, yaitu kebocoran 

daya pada bidang potongnya. Kebocoran daya yang terjadi pada antena RLSA, akan 

mengganggu aliran daya yang menyebar pada antena RLSA. Hal ini akan mengakibatkan 

menurunnya performansi antena seperti gain, bandwitdh, dan koefisien refleksi (S1,1). 

Kebocoran daya ini diterangkan pada jurnal di bawah ini. 

 

Tabel 2.2. Literatue Review Penelitian Antena RLSA Tentang Kebocoran Daya 

No  Judul Literatur Tahun Spesifikasi Hasil Penelitian 

[16] A New Size Reduction 

Method for Radial Line 

Slot Array (RLSA) 

Antennas 

2020 P0=16 

Tau = 71o 

Jari-jari = 85 mm 

Gain = 11,73 dB 

Bandwidth = 1,232 

GHz 

S1,1 = -23,69 dB 

[17] Cutting Technique for 

Constructing Small 

Radial Line Slot Array 

(RLSA) Antennas 

2021 P0=10, 12, 14, 16 

Tau = 75o -89o 

Jari-jari = 75 mm 

Gain = 8,1 dB, 

Bandwidth = 1,0 GHz 

S1,1 = -20 dB 
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2.2. Antena RLSA 

Antena RLSA (Radial Line Slot Array) adalah salah satu dari jenis antena 

directional  yang memiliki struktur terdiri dari background, radiating element, cavity 

antena dan feeder seperti pada gambar 2.1 [3].  

 

   

(a)       (b) 

Gambar 2.1. (a) Struktur Dasar Antena RLSA (b) Struktur feeder 

(Sumber: T.Purnamirza, 2013) [3] 

 

Bagian radiating element merupakan bagian depan antena RLSA yang memiliki 

banyak pasangan slot pada bagian permukaannya yang terbuat dari bahan cooper 

(tembaga). Setiap slot tersusun dengan pasangannya, dan setiap pasang slot sebanding 

dengan satu antena. Sehingga seluruh slot membentuk satu kesatuan antena array. Slot 

berfungsi sebagai tempat sinyal atau daya keluar yang selanjutnya dipancarkan ke udara 

bebas. Background juga terbuat dari bahan yang sama dengan radiating element, akan 

tetapi background tidak memiliki slot pada permukaannya sama sekali. Bagian selanjutnya 

adalah cavity yang terbuat dari bahan polypropelene dengan diameter yang sama dengan 

radiating element dan background. Cavity berfungsi sebagai pembawa sinyal atau daya 

dari feeder dan menyebarkan ke seluruh bagian cavity. Feeder adalah komponen yang 

terletak di pusat antena yang terbuat dari bahan logam alumunium. Feeder memiliki 

peranan untuk membawa sinyal atau daya dari media tranmisi menuju antena [1]. 

 

2.2.1. Sistem Kerja Antena RLSA 

Proses bagaimana antena mengirimkan sinyal informasi berbeda-beda. Antena 

RLSA melakukan proses pengiriman sinyal informasi dari media transmisi lalu menuju 

feeder yang sudah ditambahkan kepala dish, dengan tujuan untuk mengubah sinyal dari 
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TEM coaxial mode ke TEM cavity mode. Kemudian dilanjutkan proses pengiriman ke 

seluruh bagian cavity, yang selanjutnya sinyal informasi keluar melalui slot pada radiating 

element [3]. Saat daya mendekati slot, sebagian daya akan melewati keluar dari pasangan 

slot tersebut dan kemudian meradiasikan daya seperti yang digambarkan pada Gambar 2.2. 

  

   

Gambar 2.2. Sistem Kerja Antena 

(Sumber: T.Purnamirza, 2013) [3] 

 

2.2.2. Panjang Slot Antena RLSA 

Antena RLSA memiliki pasangan slot-slot yang banyak dan panjang yang berbeda-

beda. Maka dari itu diperlukan proses perhitungan yang benar dan tepat, sehingga 

gangguan yang terjadi akibat saling mengirisnya antara slot dapat dikurangi sekecil 

mungkin [3]. Perhitungan panjang slot ditentukan dengan persamaan di bawah ini: 

 

𝐿 4.9876 10 𝜌 .                  (2.1) 

 

Keterangan :  

𝜌  Jarak slot dari titik tengah antena 

𝑓  frekuensi  

 

2.2.3. Penempatan Slot Antena RLSA 

Radiating element merupakan lapisan tipis tembaga pada antena RLSA, yang 

nantinya akan diletakkan slot di atasnya. Slot ini nantinya akan menjadi tempat keluarnya 

sinyal atau daya. Setiap slot pada bagian tersebut harus ditempatkan pada posisi yang benar 

agar tidak ada slot yang saling mengiris, yang akan mengakibatkan terganggunya sinyal 

dan dapat menurunkan performansi antena [3]. Pengaturan peletakan pasangan slot dapat 

direpresentasikan pada gambar berikut di bawah ini: 
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Gambar 2.3. Koordinat Peletakan Pasangan Slot Antena 

(Sumber: T.Purnamirza, 2013) [3] 

 

Persaman untuk menempatkan posisi 1 pasang slot diatur menggunakan persamaan 

di bawah ini: 

 

𝜃 𝑎𝑟𝑐𝑡𝑎𝑛
∅

∅ ∅            (2.2) 

 

𝜃 𝑎𝑟𝑐𝑡𝑎𝑛
∅

∅ ∅            (2.3) 

 

Keterangan : 

 𝜃  sudut kemiringan slot 1 

 𝜃  sudut kemiringan slot 2 

 𝜃  sudut beamsquint pada arah elevasi 

 ∅   sudut azimuth untuk slot 1 dan slot 2 

 ∅  sudut beamsquint pada arah azimuth 

 

2.2.4. Penempatan Pasangan Slot Antena RLSA 

Setiap pasangan slot itu sebanding dengan satu antena, dan 1 pasang slot disebut 

sebagai unit radiator. Posisi unit radiator harus dihitung secara cermat, hal ini dilakukan 

untuk menghindari gangguan dari mengirisnya antara unit radiator yang dapat 

menyebabkan menurunnya performansi antena RLSA [3]. Pengaturan penempatan unit 

radiator dapat direpresentasikan pada gambar di bawah ini: 
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Gambar 2.4. Geometri Penempatan Unit Radiator 

(Sumber: T.Purnamirza, 2013) [3] 

 

Persamaan untuk menghitung unit radiator dari titik pusat seperti yang terlihat pada 

Gambar 2.4, dapat dilakukan dengan menggunakan persamaan di bawah ini: 

 

𝜌               (2.4) 

 

Keterangan: 

 𝜉
√

 

𝜌𝜌 = Posisi slot 

 𝑛  nomor ring 

 𝜆  Panjang gelombang pada cavity 

 𝜃  sudut beamsquint pada arah elevasi 

 𝜙  sudut azimuth dari posisi slot 1 dan slot 2 

 𝜙  sudut beamsquint pada arah azimuth 

 𝜀  nilai cavity permativity 

 

Dua unit radiator yang berdampingan pada ring yang berbeda, rumus jaraknya 

dihitung dengan persamaan di bawah ini: 
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𝑆               (2.5) 

 

Dua unit radiator yang berdampingan pada ring yang sama, rumus jaraknya 

dihitung dengan persamaan di bawah ini: 

 

𝑆                (2.6) 

 

Keterangan: 

 𝜆  = Panjang gelombang pada cavity 

 𝜃  = sudut beamsquint pada arah elevasi 

 𝜙 = sudut azimuth dari posisi slot 1 dan slot 2 

 𝜙  = sudut beamsquint pada arah azimuth 

 

Dari persamaan 2.6 didapatkan jarak dari pusat unit radiator adalah ¼ λg, maka 

dapat dirumuskan jarak antar slot dari titik pusat dengan persamaan sebagai berikut: 

 

𝜌 .               (2.7) 

 

𝜌 .               (2.8) 

 

2.3. Parameter Antena 

Ada beberapa parameter yang harus diperhatikan saat melakukan perancangan 

antena. Hal ini dikarenakan, antena bisa disebut bekerja dengan baik apabila parameter 

antena memenuhi standar yang ada. Parameter-parameter antena yang biasa digunakan 

untuk menganalisis suatu antena adalah Bandwidth, Directivity (Pengarahan), Efisiensi, 

Gain, Pola Radiasi (Radiation Pattern), dan koefisien refleksi. 

 

2.3.1. Beamwidth Antena 

Beamwidth merupakan lebar ukuran dari suatu pancaran antena. Untuk 

mendapatkan lebar beamwidth, adalah dengan mengukur lebar sudut pancaran main beam 
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antena [19]. Gambar di bawah ini adalah grafik pancaran daya atau pola radiasi suatu 

antena, dan sekaligus menunjukan area pancaran yang diukur beamwidthnya.  

 

Gambar 2.5. Pola Radiasi dengan Bagian-bagiannya 

(Sumber : Balanis) [19] 

 

Keterangan: 

1. Major lobe (lingkaran besar) atau juga sering disebut sebagai main beam 

merupakan area dengan intensitas pancaran tertinggi pada saat antena 

memancarkan sinyal atau daya, dan merupakan area yang dihitung lebar 

pancarannya. Pada gambar 2.5. di atas dapat dilihat pola radiasi yang fokus 

pada satu arah, tapi ada juga dari jenis antena lain yang memiliki main beam 

yang fokus lebih dari satu arah seperti antena dipole [19]. 

2. Selain dari major lobe, semua arah pancaran yang tidak memancarkan sinyal ke 

arah yang diinginkan disebut sebagai minor lobe. Salah satu bagian dari dari 

minor lobe adalah Side lobe (lingkaran sisi) yang merupakan area dengan 

intensitas pancaran yang lebih kecil dari major lobe, dengan arah pancaran yang 

tidak diinginkan [19].  

3. Selain itu ada juga Back lobe (lingkaran belakang) yang juga bagian dari minor 

lobe seperti side lobe. Back lobe memiliki pancaran 180o membelakangi major 

lobe [19]. Hal ini dapat diartikan bahwa tidak semua sinyal yang dipancarkan 

mengarah seluruhnya pada arah pancar yang diinginkan. 

Ada beberapa jenis cara dalam mengukur beamwidth, dan yang paling banyak 

digunakan adalah Half Power Beamwidth (HPBW). HPBW atau lebar pancaran setengah 

daya adalah cara menghitung sudut lebar pancaran saat daya berkurang 50 % (-3dB) dari 
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pancaran utama. Selain itu ada juga First Null Beamwidth (FNBW) atau lebar pancaran 

bernilai nol adalah cara menghitung sudut pancaran dari daya pancaran nol sampai dengan 

nol pada pola radiasi bagian main beam [19]. 

 

2.3.2. Gain 

Gain (kekuatan pancaran) merupakan parameter yang sangat dekat kaitannya 

dengan direktivitas dan efisiensi. Gain adalah parameter yang mengukur radiasi sinyal atau 

daya yang dipancarkan pada arah puncak pola radiasi, dan dibandingkan dengan radiasi 

sinyal atau daya yang dipancarkan antena isotropis [20]. Arah pancaran akan lebih terarah 

pada antena yang memiliki kekuatan pancaran yang besar dibandingkan dengan antena 

dengan kekuatan pancaran yang kecil, walaupun itu berasal dari antena yang sama persis. 

Besar kekuatan pancaran dari suatu antena akan menentukan kemampuan antena dalam 

mengkonsentrasikan daya suatu antena [19]. Rumus perhitungan gain antena dapat dilihat 

pada rumus di bawah ini: 

 

𝐺 𝜀 𝐷                                (2.9) 

 

Keterangan : 

 𝐺 = Gain antena 

 𝐷 = Direktivitas antena 

 𝜀  = Efisiensi antenna 

 

2.3.3. Direktivitas  

Direktivitas (pengarahan) antena adalah parameter yang membandingkan kekuatan 

radiasi antena pada arah yang diradiasikan dengan kekuatan radiasi yang dipancarkan pada 

seluruh arah (antena isotropis) sebagai fungsi arah [19]. Antena isotropis merupakan 

antena yang menyebarkan daya ke seluruh arah [20]. Antena ini digunakan sebagai acuan 

untuk mengetahui seberapa mengarahkah sinyal radiasi, walaupun kenyataannya antena ini 

sama sekali tidak ada dalam kenyataan. Apabila nilai direktivitas semakin tinggi, itu berarti 

antena meradiasikan daya lebih terkonsentrasi pada suatu arah [20, 19]. Direktivitas antena 

dapat ditentukan melalui persamaan berikut: 
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𝐷             (2.10) 

 

Keterangan: 

 𝑈  = intensitas radiasi antena 

 𝑈  = intensitas radiasi antena isotropis 

 𝑃  = daya yang diradiasikan 

 

2.3.4. Efisiensi Antena 

Efisiensi antena merupakan rasio antara daya dari suatu antena yang memancarkan 

sinyal dengan daya yang dimasukkan ke dalam rangkaian antena tersebut. Daya masukkan 

antena merupakan daya total dari daya yang diradiasikan dengan daya yang hilang. Suatu 

antena akan dikatakan memiliki efisisensi tinggi apabila daya yang diradiasikan lebih 

banyak dibanding dengan daya yang hilang pada antena tersebut [19]. Untuk mencari 

efisiensi antena dapat menggunakan rumus di bawah ini:  

 

𝜀            (2.11) 

 

Keterangan : 

 𝜀   = Efisiensi antena 

𝑃   = Daya yang diradiasikan antena 

 𝑃  = Daya yang dimasukan ke antena 

 𝑃   = Daya yang hilang 

 

2.3.5. Bandwidth 

Bandwidth antena merupakan rentang frekuensi kerja suatu antena yang membuat 

antena itu bekerja dengan baik apabila menggunakan frekuensi pada rentang frekuensi 

tersebut [19]. Bandwidth suatu antena dapat ditentukan menggunakan persamaan berikut 

ini: 
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𝐵𝑊 𝑓𝑚𝑎𝑥 𝑓𝑚𝑖𝑛            (2.12) 

 

Keterangan : 

𝐵𝑊 = bandwidth 

 𝑓𝑚𝑖𝑛 = frekuensi terendah  

 𝑓𝑚𝑎𝑥 = frekuensi tertinggi 

 

2.3.6. Pola Radiasi Antena 

Pola radiasi antena merupakan sebuah gambar grafik yang melambangkan daya 

atau radiasi pada antena sebagai sebuah fungsi posisi pada koordinat spheris (koordinat 

bola), dan biasanya diukur pada medan jauh. [19]. Berdasarkan pola radiasinya, maka 

antena dikelompokkan menjadi beberapa jenis yaitu:  

1. Antena directional, merupakan antena yang memiliki pola radiasi dengan sudut 

pancaran yang kecil (narrow beamwidth) dengan daya sinyal lebih terarah pada 

titik tertentu sebagai puncaknya dengan jarak jangkauan yang jauh. Antena ini 

cocok untuk komunikasi point to point seperti yang ditunjukan pada gambar 

2.6. (a). Contoh jenis antena directional seperti antena parabola, RLSA, panel, 

yagi, dan sektoral. 

2. Antena Omni-directional, merupakan antena yang memiliki pola radiasi 

dengan sudut pancaran yang besar (wide beamwidth) yaitu 360o jika dilihat 

pada bidang tertentu. Daya sinyal antena ini sama besar ke segala arah dan 

jarak jangkauan lebih pendek tetapi dengan cakupan yang luas cocok untuk 

komunikasi point to multipoint seperti yang ditunjukan pada gambar 2.6. (b).  

                                          

 

 

Gambar 2.6. Pola radiasi (a) directional, (b) omni-directional 

(Sumber : Balanis, 2016) [19] 

(a) (b) 
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2.3.7. Koefisien refleksi (S1,1) 

Koefisien refleksi merupakan nilai perbandingan antara amplitudo gelombang yang 

dipantulkan terhadap amplitudo dari gelombang yang dikirimkan. Koefisien refleksi 

memiliki keterkaitan dengan VSWR (Voltage Standing Wave Ratio). VSWR adalah 

gabungan dari sinyal atau daya yang dikirimkan menuju antena dengan sebagian sinyal 

dipantulkan. Sinyal yang dipantulkan akan saling inteferensi dengan sinyal yang 

dikirimkan, sehingga amplitudo sinyal berubah-ubah. Besarnya VSWR dapat dicari 

menggunakan rumus di bawah ini: 

    

𝑉𝑆𝑊𝑅             (2.13) 

 

Berdasarkan rumus dapat dilihat semakin besar koefisien refleksi semakin besar 

nilai VSWR dan itu berarti antena tidak bekerja dengan baik. Fungsi dari parameter ini 

adalah untuk mengetahui sebesar apa daya yang dipantulkan kembali saat dikirimkan ke 

antena. Hal ini dikarenakan daya yang dipantulkan kembali menuju transmisi dapat 

mengganggu daya yang dikirimkan sehingga nilai VSWR menjadi tinggi seperti yang 

dijelaskan sebelumnya. Besarnya koefisien refleksi dapat dirumuskan dengan persamaan 

berikut ini [19]. 

 

𝛤                   (2.14) 

 

            𝑘𝑜𝑒𝑓𝑖𝑠𝑖𝑒𝑛 𝑟𝑒𝑓𝑙𝑒𝑘𝑠𝑖 𝑑𝐵  20 log|𝛤|         (2.15) 

 

Keterangan: 

𝛤  = koefisien refleksi 

𝑉   = amplitudo tegangan maksimum 

𝑉  = amplitudo tegangan minimum 

𝑉  = amplitudo tegangan dikirimkan 

𝑉  = amplitudo tegangan dipantulkan 
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2.4. Power leakage 

Pasangan-pasangan slot yang ada pada antena RLSA biasanya diletakkan secara 

merata pada bagian permukaan antena, seperti yang ditunjukan pada gambar 2.7. (a). 

Seperti yang dijelaskan sebelumnya bahwa sinyal akan mengalir keluar melalui slot, 

sehingga untuk mendapatkan koefisien refleksi yang lebih rendah maka dibutuhkan jumlah 

slot yang lebih banyak. Maka dari itu slot harus sedekat mungkin satu sama lain agar dapat 

memuat lebih banyak slot [16, 17].  

Pada penelitian [6] telah dilakukan penelitian untuk mengecilkan koefisien refleksi 

dengan Teknik extream beamsquint. Antena yang dihasilkan pada penelitian ini memiliki 

bagian slot yang berkumpul pada satu area dan ada bagian yang tidak ada slot sama sekali 

seperti pada gambar 2.7. (b). Area yang tidak memiliki slot pada antena sama sekali tidak 

membantu apapun karena pada area tersebut sama sekali tidak memiliki slot untuk 

meradiasikan sinyal [16, 17]. Maka dari itu bagian antena yang tidak memiliki slot dapat 

dipotong seperti yang diperlihatkan pada gambar 2.7 (c). 

 

 

(a)                                   (b)                                        (c)     

Gambar 2.7. (a) Antena RLSA 1 Lingkaran, (b) Antena RLSA dengan Teknik 

Extreme Beamsquint, (c) Antena RLSA ½ Lingkaran 

(Sumber: T. Purnamirza, 2020) [17] 

 

Keuntungan dari teknik pemotongan ini adalah dapat mereduksi ukuran antena. 

Selain itu dengan teknik ini dapat meningkatkan performansi antena, karena kepadatan 

daya didalam antena semakin meningkat setelah dipotong. Hal ini akan membuat semakin 

banyak sinyal atau daya yang melewati slot. Sehingga dapat meningkatnya gain, 

memperbesar lebar frekuensi kerja, dan memperkecil koefisien refleksi [16, 17].  
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Walaupun dapat mengecilkan ukuran antena dengan teknik pemotongan ini, teknik 

ini memiliki efek negatif. Seperti yang dilihat pada gambar 2.8. bahwa dengan melakukan 

teknik pemotongan dapat mengakibatkan kebocoran daya (power leakage) di sepanjang 

bidang potong antena. Setelah antena dipotong sebagian sinyal keluar melalui bidang 

potong dibandingkan dengan melalui slot [16, 17]. Efek dari kejadian ini dapat 

mengakibatkan terganggunya aliran daya pada antena RLSA, sehingga hal ini dapat 

menurunkan gain, memperbesar koefisien refleksi, dan memperkecil bandwidth seperti 

yang ditunjukan pada gambar di bawah ini.  

 

 

(a)                              (b) 

Gambar 2.8. (a) Aliran Daya Pada Antena RLSA 1 Lingkaran Penuh, (b) Aliran 

Daya Pada Antena RLSA ½ Lingkaran 

(Sumber: T.purnamirza, 2020) [16, 17] 

 

Pada gambar di atas dapat dilihat pada antena 1 lingkaran sinyal menyebar secara 

merata ke seluruh bagian antena. Tetapi apabila dilihat pada antena ½ lingkaran pada 

bidang potong terjadi kebocoran daya seperti yang sudah dijelaskan sebelumnya. 

Kebocoran Daya 
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BAB III 

METODE PENELITIAN 

 

3.1. Metode Penelitian 

Metode penelitian yang digunakan pada penelitian ini adalah metode penelitian 

kuantitatif. Metode penelitian kuantitatif merupakan jenis metode penelitian yang proses 

penelitian dikerjakan secara terstruktur, dengan rencana yang matang, dan dengan 

perhitungan yang akurat. Biasanya Penelitian Kuantitatif berhubungan dengan angka pada 

suatu alat ukur, dan grafik.  

 

3.2. Tahapan Penelitian 

 

 

1 

Menyiapkan perangkat dan aplikasi 

Mulai 

Melakukan studi literatur 

Menggambar antena RLSA ½ lingkaran dengan penutup tembaga pada 
bidang potong berdasarkan skenario pada aplikasi CST 2010  

Menentukan spesifikasi antena RLSA dan skenario yang akan di simulasi dengan 
aplikasi CST 2010 
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Gambar 3.1. Flow Chart Penelitian 

 

3.3. Studi Literatur 

Penelitian ini yang berjudul “Analisa Efek Penutup Tembaga Pada Antena Radial 

Line Slot Array ½ Lingkaran” adalah judul penelitian yang disarankan oleh dosen 

pembimbing untuk penulis. Pada awalnya penulis mencari literatur yang berhubungan 

dengan judul penelitian seperti thesis, buku, dan jurnal-jurnal ilmiah. Lalu setelah itu 

referensi tersebut dipelajari, dan juga melakukan diskusi dengan dosen pembimbing. 

Tahapan-tahapan tersebut dilakukan dengan tujuan untuk mempermudah dalam 

menemukan solusi dalam menyelesaikan penelitian ini.  

 

 

 

 

 

Pembuatan laporan tugas akhir 

2 

Mensimulasikan antena RLSA ½ 
lingkaran dengan penutup tembaga 

pada bidang potong dengan aplikasi 
CST 2010 berdasarkan skenario 

Analisa hasil simulasi 

Selesai 

Semua skenario sudah 
disimulasikan ? 

Ya  

Tidak  
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3.4. Perangkat dan Aplikasi 

Dalam penelitian ini dibutuhkan perangkat keras dan perangkat lunak dengan 

spesifikasi yang baik untuk mendesain antena. Berikut ini merupakan daftar perangkat 

keras serta perangkat lunak atau aplikasi yang digunakan dalam perancangan antena RLSA 

pada penelitian ini:  

1. Perangkat keras yang digunakan adalah Laptop dengan spesifikasi: 

- Sistem Operasi: Windows 10 

- Processor: Intel Core i3 

- Memory RAM: 4 GB 

- HDD: 1 TB 

2. Perangkat lunak yang digunakan pada penelitian ini terdiri dari 2 macam yaitu: 

a. Program yang berbasiskan bahasa program VBA 

(RLSA_untuk_5.8_GHz.mcs dan Memotong_RLSA_untuk_5.8_GHz.mcs).  

Program digunakan untuk membuat rancangan antena RLSA lebih simpel 

dan lebih mudah pada aplikasi CST Microwave Studio 2010   

b. CST Microwave Studio 2010 

Aplikasi ini merupakan aplikasi untuk membuat rancangan antena dan 

tempat untuk simulasi antena. 

 

3.5. Menentukan Spesifikasi dan Parameter Antena RLSA 

Penentuan spesifikasi dan parameter antena bertujuan sebagai acuan atau standar 

dalam merancang antena RLSA. Dengan menentukan standar, penulis dapat menentukan 

antena dapat bekerja dengan baik atau tidak. Parameter yang penulis gunakan pada 

penelitian ini adalah sebagai berikut: 

 

Tabel 3.1. Parameter Perancangan Antena RLSA 

Parameter Nilai 

Frekuensi  5,8 GHz 

Beamsquint  87o 

Slot pada ring pertama 14 

Panjang slot 0,5 mm 

Lebar slot 1 mm 
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Tabel 3.1. Parameter Perancangan Antena RLSA (Lanjutan) 

Jari-jari cavity 115 mm 

Tebal cavity 8 mm 

Cavity permittivity 2,33 

Tebal radiating element 

dan ground 

0,1 mm 

 

Tidak hanya itu saja, parameter pada feeder antena juga ditentukan. Parameter 

feeder antena dapat dilihat pada tabel 3.2. di bawah ini:  

 

Tabel 3.2. Parameter Feeder Pada Antena RLSA 

Parameter Nilai 

Tinggi Silinder Tembaga 3 mm 

Radius Silinder Tembaga 1,4 mm 

Gap Udara Bagian Atas 1 mm 

Gap Udara Bagian Bawah 4 mm 

  

Performansi antena yang dihasilkan menggunakan parameter antena di atas, 

menghasilkan antena dengan spesifikasi di bawah ini: 

1. Gain = 15,16 dBi 

2. Bandwidth = 0,9986 GHz 

3. Koefisien refleksi = -23,66 dB 

 

3.6. Menggambar Antena RLSA ½ Lingkaran dengan Tembaga Dengan Berbagai 

Panjang  

Pada perancangan antena RLSA dibutuhkan persiapan yaitu dengan menggunakan 

perangkat keras dan perangkat lunak seperti yang sudah dijelaskan sebelumnya. Apabila 

ingin mengetahui langkah lebih detail dapat dilihat pada lampiran A. Gambar di bawah ini 

merupakan tahapan menggambar antena RLSA ½ lingkaran yang selanjutnya ditambahkan 

penutup tembaga pada bidang potong antena. 
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Gambar 3.2. Alur Tahapan Menggambar Antena RLSA ½ Lingkaran dengan Penutup 

Tembaga pada Bidang Potong 

 

3.6.1. CST Microwave Studio 2010 

CST Microwave Studio 2010 adalah software yang digunakan untuk merancang 

model antena RLSA. Perancangan model antena RLSA berdasarkan parameter input yang 

telah ditentukan. Penggambaran model antena RLSA dibantu juga dengan VBA software. 

Setelah menggambar model antena RLSA kemudian dilakukan simulasi. 

 

3.6.2. Menggambar Antena RLSA ½ Lingkaran 

Setelah menentukan nilai inputan untuk membuat Antena RLSA, masukkan nilai 

inputan dalam Bahasa Pemrograman VBA (RLSA_untuk_5.8_GHz.mcs) yang selanjutnya 

dijalankan untuk mendapatkan rancangan antena RLSA 1 lingkaran penuh yang bekerja 

pada frekuensi 5,8 GHz seperti pada gambar 3.3. (a). 

 

 

Mulai 

Buka CST Studio 2010 

Menggambar Antena RLSA ½ lingkaran 

Menambahkan penutup tembaga dengan skenario yang ditetapkan 

Selesai 
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(a)                           (b) 

Gambar 3.3. (a) Antena RLSA 1 Lingkaran, (b) Antena RLSA ½ Lingkaran  

 

Setelah Rancangan antena RLSA 1 lingkaran didapatkan, selanjutnya melakukan 

pemotongan antena sehingga menjadi antena ½ lingkaran menggunakan bahasa 

pemrograman VBA (Memotong_RLSA_untuk_5.8_GHz.mcs) seperti yang terlihat pada 

gambar 3.3. (b). 

 

3.6.3. Penambahan Penutup Logam pada Bidang Potong Antena RLSA ½ 

Lingkaran 

Setelah menggambar antena RLSA ½ lingkaran, langkah selanjutnya 

menggambarkan penutup tembaga pada bidang potong antena RLSA ½ lingkaran dengan 

beberapa skenario dengan berbagai panjang dan beberapa kondisi. Skenario penelitian 

terbagi 4 macam seperti pada gambar di bawah ini: 

                               

(a)                                 (b)                       
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                                                      (c)                  (d) 

Gambar 3.4. (a) Penutup Tembaga di Antara Feeder dan Tepi Antena, (b) Penutup 

Tembaga dari Tepi Antena, (c) Penutup Tembaga dari Arah Feeder, (d) Penutup Tembaga 

di Tengah Bidang Potong di Atas Cavity Tambahan  

 

a. Pada skenario 1, penutup tembaga ditambahkan tepat di tengah-tengah antara 

feeder dan tepi pada bidang potong antena RLSA. Penutup tembaga pada skenario 

ini memiliki ketebalan sebesar 0,1 mm dan panjang yang bervariasi dari 1 mm 

sampai 115 mm, hingga menutupi keseluruhan bidang potong antena RLSA seperti 

pada gambar 3.4. (a). 

b. Skenario 2 adalah memasang penutup tembaga pada bidang potong di tepi antena 

RLSA seperti yang telihat pada gambar 3.4. (b). Penutup tembaga pada skenario ini 

memiliki ketebalan sebesar 0,1 mm dan panjang yang bervariasi yaitu dari 1 mm 

sampai 115 mm sampai ke arah feeder seperti yang ditunjukan arah panah pada 

gambar 3.4. (b). 

c. Skenario 3 adalah memasang penutup tembaga yang posisinya dekat dengan arah 

feeder. Pada skenario 3 ini, awal peletakan penutup tembaga tidak benar-benar pas 

di dekat pada feeder, akan tetapi diberi jarak sekitar 15 mm dari feeder. Ukuran 

penutup tembaga memiliki ketebalan sebesar 0,1 mm dan panjang yang bervariasi 

sebesar dari 1 sampai 100 mm sampai ke tepi bidang potong antena seperti yang 

ditunjukan oleh tanda panah pada gambar 3.4. (c). 
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d. Pada skenario 4, antena RLSA ditambahkah lagi cavity pada bagian potong antena 

RLSA sebesar . Setelah itu, baru menambahkan penutup tembaga di tengah dekat 

dengan feeder. Ukuran penutup tembaga memiliki ketebalan sebesar 0,1 mm dan 

panjang yang akan disimulasikan 0.1 𝜆, 0.3 𝜆, 0.6 𝜆, 0.9 𝜆, dan 1.2 𝜆 seperti pada 

gambar 3.4. (d). 

Antena RLSA akan disimulasikan dengan tembaga dengan berbagai panjang sesuai 

dengan skenario diatas. Hal ini dilakukan untuk mengatahui apakah ada pengaruh posisi 

dan panjang penutup tembaga terhadap kebocoran daya (power leakage). 

 

3.7. Mensimulasikan Antena RLSA ½ Lingkaran dengan Tembaga Pada Bidang Potong 

Simulasi model antena RLSA dilakukan menggunakan CST Studio Suite  dan 

bahasa pemrograman VBA. Simulasi rancangan dilakukan dengan beberapa skenario 

perancangan untuk mengetahui hasil yang akan diperoleh setelah simulasi. Skenario 

perancangannya yaitu dimulai dengan penutup tembaga dengan panjang 1 mm hingga 100 

mm. Simulasi terus dilakukan sampai 4 skenario penutup tembaga seluruhnya sudah 

disimulasi.  

 

3.8. Analisa Hasil 

Setelah memperoleh semua hasil pengukuran simulasi berdasarkan skenarionya, 

langkah selanjutnya melakukan analisa dari hasil simulasi yang diperoleh. Hasil simulasi 

akan dibandingkan antara seluruh antena yang disimulasi dengan penutup tembaga dan 

tanpa tembaga. Hal ini dilakukan untuk mengetahui apakah performansi antena dapat 

ditingkatkan dengan menambahkan penutup tembaga pada bidang potong antena RLSA ½ 

lingkaran. Hasil simulasi yang diperhatikan adalah gain, koefisien refleksi, dan bandwidth. 
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BAB V 

KESIMPULAN DAN SARAN 

 

5.1. Kesimpulan 

Penurunan performansi seperti gain, bandwidth, dan S1,1 pada antena RLSA ½ 

lingkaran, diakibatkan oleh kebocoran daya pada bidang potongnya. Penulis berpikir dengan 

menutup bidang potong yang mengalami kebocoran daya dapat meningkatkan performanssi 

antena. Pada penelitian ada beberapa hal yang dapat disimpulkan, yaitu: 

1. Antena bekerja lebih baik apabila posisi dan panjang penutup tembaga pada bidang 

potong berada di tepi antena, tetapi bukan berarti performansi antena akan 

mendapatkan nilai terbaik. Sebagai contohnya dapat dilihat dari skenario 2 dengan 

panjang 84 mm sebagai bandwidth terbaik sebesar 1,1047 GHz, lalu skenario 1 

dengan panjang 63 mm sebagai S1,1 terbaik sebesar -35,82 dB, dan skenario 2 

dengan panjang 93 mm sebagai gain terbaik sebesar 15,51 dB. 

2. Posisi dan panjang penutup tembaga yang dekat dengan feeder dapat memperburuk 

performansi antena. dapat dilihat dari hasil simulasi skenario 1 dan 2, panjang 

penutup tembaga yang diletakkan sampai dengan ± 15 mm mendekati Feeder 

memiliki nilai S1,1 ≥ -10 mm, dan bandwidth yang tidak bekerja pada frekuensi 5,8 

GHz sehingga tidak sesuai standar acuan antena. Hal ini semakin terbukti dari 

skenario 3 yang posisi penutup tembaga dekat dengan feeder. 

 

5.2. Saran  

Pada pengembangan penelitian selanjutnya, penulis menyarankan untuk menutup 

seluruh sisi samping cavity antena RLSA ½ lingkaran dengan penutup tembaga, atau 

merancang antena 1 lingkaran penuh dengan posisi feeder di tepi antena RLSA dan menutup 

cavitiy di area sekitar feeder untuk mengetahui pengaruhya terhadap performansi antena 

RLSA. 
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LAMPIRAN A 

MERANCANG MODEL ANTENA RLSA ½ LINGKARAN DENGAN 

LAPISAN PENUTUP TEMBAGA PADA BIDANG POTONG 

 

 Pada Lampiran ini akan menjelaskan bagaimana cara merancang model antena 

RLSA pada aplikasi CST MICROWAVE STUDIO 2010 menggunakan software yang 

berbasiskan bahasa pemrograman VBA, sehingga pembuatan model antena RLSA bisa 

lebih cepat, akurat, dan mudah. Langkah-langkah nya dapat dilihat di bawah ini: 

1. Buka aplikasi CST MICROWAVE STUDIO 2010 pada hardware (Laptop/PC) 

dan muncul tampilan seperti pada gambar A.1. Lalu tekan ikon CST 

Microwave Studio dan tekan OK. 

 

Gambar A.1. Tampilan Awal CST Microwave Studio 2010 

 

2. Langkah selanjutnya pilih Antena Planar lalu tekan OK. 

 

Gambar A.2. Tampilan Create New Project 

  

1 

2 
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3. Lalu selanjutnya pilih menu Macros dan pilih tombol Open VBA Macro Editor 

seperti pada gambar di bawah ini. 

 

Gambar A.3. Tampilan Menu Macros  

 

4. Lalu tekan Ctrl+O dan pilih file RLSA_untuk_5.8_GHz lalu tekan Open. 

 

Gambar A.4. File Macro Untuk Merancang Antena RLSA 

 

5. Setelah itu masukkan nilai parameter input untuk merancang antena RLSA. 

Nilai parameter input yang digunakan untuk merancang antena RLSA yaitu: 

a. Jari-jari kaviti yang digunakan 115 mm 

b. Po yang digunakan memiliki nilai 14 
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c. tau beamsquint elevasi yang digunakan sebesar 87o 

d. Frekuensi kerja (fo) yang digunakan 5.8 GHz 

 

 

Gambar A.5. Program VBA untuk Membuat Antena RLSA 

 

6. Lalu tekan tombol Run Macro dan menunggu prosesnya hingga selesai dan 

hasilnya dapat dilihat pada gambar di bawah ini. 

 

Gambar A.6. (a) Tombol Run Macro (b) Hasil Model Rancangan Antena RLSA  

 

7. Langkah selanjutnya adalah melakukan penyatuan slot dengan klik ring di 

Navigation Tree, pilih menu Object > Boolean > Add, dan ubah namanya 

menjadi Slot 0.2.2. 
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Gambar A.7. Proses Penyatuan Slot 

 

8. Tekan tombol menu Open VBA Macros Editor kembali, lalu tekan Ctrl+O dan 

buka file Memotong_RLSA_untuk_5.8_GHz. Setelah itu isi nilai pada sudut 

putar dengan nilai 0. 

 

Gambar A.8. Program VBA untuk Memotong Antena RLSA 

 

9. Setelah itu tekan tombol Run Macro dan tunggu prosesnya hingga selesai. 

Setelah selesai hasilnya akan terlihat seperti pada gambar di bawah ini. 
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Gambar A.9. Antena RLSA ½ Lingkaran 

 

10. Bersihkan slot-slot yang tidak digunakan dengan cara klik kanan pada Slot 

0.2.2 > Separate Shape > pilih Slot yang terpotong > delete 

 

Gambar A.10. Proses Penghapusan Slot 
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11. Lakukan penyatuan Slot setelah menghapus slot-slot yang tidak digunakan, 

tekan ring > Object > Boolean > Add, dan ubah namanya kembali menjadi Slot 

0.2.2. Lanjutkan dengan melubangi radiating antena dengan cara klik 

Component > Antena > Radiating > Object > Boolean > Insert > Klik pada 

ring Slot 0.2.2 > Enter. 

 

Gambar A.11. Pemasangan Slot pada Radiating Antena RLSA ½ Lingkaran 

 

12. Tekan ikon create brick  pada bagian atas kiri seperti yang di tandai 

lingkaran merah, untuk membuat lapisan tembaga pada bidang potong seperti 

pada gambar di bawah ini: 
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Gambar A.12. Tampilan Ikon Create Brick 

 

13. Setelah itu tekan tombol Esc, dan akan muncul dialog box brick seperti pada 

gambar A.13. Setelah itu isi koordinat X, Y, dan Z pada dialog box sesuai 

dengan skenario penelitian untuk membuat lapisan tembaga pada bidang potong 

antena. 

 

Gambar A.13. Tampilan Dialog Box Brick 

 

14. Setelah itu lakukan lagi dari langkah 12, untuk membuat lapisan tembaga pada 

bidang potong antena RLSA ½ lingkaran di sisi lainnya seperti pada gambar 

A.14 yang dilingkari merah. Hasil akhirnya dapat dilihat seperti pada gambar di 

bawah ini. 
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Gambar A.14. Antena RLSA ½ lingkaran dengan Lapisan Tembaga pada 

Bidang Potong Antena dari 4 Skenario 

 

15. Setelah penambahan lapisan penutup tembaga, langkah selanjutnya adalah 

menentukan range frekuensi dengan klik icon , lalu mengisi kolom Fmin = 

4.8 GHz, dan Fmax = 6.8 GHz. 

 

Gambar A.15. Pengaturan Range Frekuensi 

 

16. Selanjutnya lakukan pencatuan Feeder dengan cara ubah  

menjadi Back, lalu klik Feeder pada Components, perbesar gambar pada arah 

feeder, klik , lalu double klik pada bagian putih Feeder. 
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Gambar A.16. Proses Pencatuan Lubang Feeder 

 

17. Lakukan penentuan dimensi feeder dengan mengunakan Waveguide Ports atau 

klik > lalu klik OK. 

 

Gambar A.17. Tampilan Dialog Box Waveguide Ports 
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18. Lalu agar dapat menunjukan hasil pola radiasi saat setelah simulasi, dengan 

cara klik Solve > Field Monitor > pilih Farfiled/RCS > pilih frekuensi 5.8 GHz 

> klik Ok. 

 

Gambar A.18. Tampilan Field Monitor 

 

19. Jalankan simulasi dengan cara klik Solve > Transient Solver > Transient 

Solver Parameter > Start. 

  

Gambar A.19. Tampilan Transient Solver 
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LAMPIRAN B 

HASIL SIMULASI ANTENA RLSA ½ LINGKARAN DENGAN 

LAPISAN TEMBAGA 

 

Tabel B.1. Hasil Simulasi Skenario 1 

Lapisan Tembaga di Antara Feeder dan Tepi Antena 

Panjang (mm) Realized Gain (dB) Bandwidth (GHz) S11 (dB) 

0 15,16 0,9986 -23,66 

3 15,03 1,0135 -19,46 

6 14,99 1,0208 -19,22 

9 14,94 1,0382 -19,13 

12 14,92 1,0579 -19,13 

15 14,90 1,0826 -19,52 

18 14,91 1,0862 -20,03 

21 14,87 1,0931 -20,41 

24 14,86 0,9193 -21,15 

27 14,81 0,8924 -22,10 

30 14,74 1,0695 -23,86 

33 14,60 0,9125 -24,04 

36 14,43 0,8836 -23,15 

39 14,10 0,8819 -22,72 

42 14,01 0,8801 -20,93 

45 14,22 0,8988 -20,89 

48 14,31 0,926 -21,43 

51 14,40 0,9457 -21,98 

54 14,45 0,9376 -23,28 

57 14,50 1,089 -24,95 

60 14,52 1,0524 -29,01 

63 14,58 0,9608 -35,82 

66 14,65 0,943 -30,35 

69 14,74 0,9322 -22,71 

72 14,74 0,9439 -18,07 

75 14,62 0,7494 -14,46 

78 14,32 0,7109 -11,87 

81 13,88 X X 

84 13,26 X X 

87 12,58 X X 

90 11,91 X X 

93 11,28 X X 

96 10,76 X X 

99 10,06 X X 
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Tabel B.1. Hasil Simulasi Skenario 1 (Lanjutan) 

102 9,852 X X 
105 9,431 X X 

 

Tabel B.2. Hasil Simulasi Skenario 2 

Lapisan Tembaga dari Tepi Antena 

Panjang (mm) Realized Gain (dB) Bandwidth (GHz) S11 (dB) 

0 15,16 0,9986 -23,66 

3 13,47 1,0045 -24,83 

6 13,39 1,0118 -20,39 

9 13,97 1,0262 -19,37 

12 14,39 1,0209 -19,69 

15 14,63 1,0075 -20,39 

18 14,76 1,0091 -21,13 

21 14,80 1,0103 -21,71 

24 14,79 1,0057 -21,90 

27 14,77 1,0049 -21,84 

30 14,78 0,999 -21,81 

33 14,80 0,9918 -22,62 

36 14,77 0,9888 -24,58 

39 14,58 0,9857 -25,10 

42 14,33 0,9986 -20,88 

45 14,38 1,0049 -17,51 

48 14,87 1,0055 -17,10 

51 15,11 0,9995 -18,25 

54 15,19 0,996 -19,21 

57 15,13 0,9979 -19,27 

60 15,07 1,0223 -18,57 

63 14,98 1,0739 -18,19 

66 14,96 1,0864 -18,59 

69 14,91 0,8784 -19,45 

72 14,63 0,8716 -21,26 

75 13,82 1,063 -16,98 

78 14,64 0,8789 -15,77 

81 14,95 0,9054 -17,03 

84 15,09 1,1047 -18,43 

87 15,27 0,9722 -20,83 

90 15,46 0,9519 -22,70 

93 15,51 0,9432 -17,23 

96 14,91 0,738 -11,087 

99 13,62 X X 

102 12,11 X X 

105 10,99 X X 
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Tabel B.3. Hasil Simulasi Skenario 3 

Lapisan Tembaga dari Arah Feeder 

Panjang (mm) Realized Gain (dB) Bandwidth (GHz) S11 (dB) 

0 15,16 0,9986 -23,66 

3 13,98 X -7,67 

6 13,6 X -7,16 

9 13,54 X -7,23 

12 13,56 X -7,3 

15 13,47 X -7,14 

18 13,37 X -7,05 

21 13,26 X -7,05 

24 13,26 X -7,08 

27 13,28 X -7,12 

30 13,27 X -7,09 

33 13,29 X -7,09 

36 13,3 X -7,11 

39 13,24 X -7,2 

42 13,15 X -7,32 

45 13,07 X -7,41 

48 13,04 X -7,47 

51 13,03 X -7,46 

54 13,01 X -7,44 

57 13 X -7,44 

60 13,02 X -7,47 

63 13,01 X -7,5 

66 12,97 X -7,56 

69 12,92 X -7,56 

72 12,85 X -7,5 

75 12,8 X -7,51 

78 12,77 X -7,53 

81 12,77 X -7,55 

84 12,77 X -7,56 

87 12,71 X -7,54 

90 12,53 X -7,47 

93 12,38 X -7,25 

96 12,8 X -7,09 

99 13,06 X -7,11 

100 13,12 X -7,22 
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Tabel B.4. Hasil Simulasi Skenario 4 

Lapisan Tembaga di Tengah Bidang Potong di Atas Cavity Tambahan 

Panjang (mm) Realized Gain (dB) Bandwidth (Ghz) S11(dB) 

0 15,16 0,9986 -23,66 

0,1 lambda 14,36 0,7367 -23,95 

0,3 lambda 14,36 0,7307 -23,30 

0,6 lambda 14,38 0,7325 -23,26 

0,9 lambda 14,54 0,7289 -23,82 

1,2 lambda 14,45 0,7291 -23,78 
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